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BEST PRACTICES COURSE – WEEK 17 – Complex Modeling PART 3- 
Multi-Story Buildings 
 

Hello, this is Eric Bobrow.  In this ArchiCAD video tutorial, we'll look at how you can create a multiple 

story building in a variety of different ways starting from a very simple conceptual model and getting all 

the way up to a detailed model that gives you very clean sections and elevations directly from the 

model. [0:00:19] 

So we will start out by drawing a box of walls here.  I'll go up to the upper story and show the lower 

story as a trace reference, and then I'll draw a smaller set of walls here; then go and create some 

interior partitions and drag it by eye, like that.  When I go to 3D and I take an axonometric view so we 

can get a quick overview of this, you can see a very simple building, but it's very clean.  This wall is 

stacked on top of the wall below, but ArchiCAD removes the line in between because they have the 

same material and they share the same plane; very cleanly done.  [0:01:28] 

Now we don't have a floor yet, so let me go ahead and put in the floor with the Slab tool, and we will 

put in a floor inside this space.  So this is one way that you can model with the walls stacked on top of 

each other and the slab inside.  I'm going to show you several different ways that we can do this.  I'm 

going to use the Marquee tool here with the heavy selection to be able to do multiple stories, and then I 

will go and multiply and create two copies of the entire building.  [0:02:03] 

So I'll go along here, and it's telling me that when I did this I was actually working on more than one 

story.  There were elements that were created on other stories and I said yes, I understand and I know 

that, do continue.  Now we're looking at the second set here and what I'm going to do is actually take 

the slab, and instead of having it inside, I will extend it out using the option for offset in all directions.  I 

will extend it out to the edge, so that it now goes underneath these walls.  [0:02:41] 

And when I take a look at just this set of elements here in the marquee, we will see that we now have a 

little bit more complicated and right now a little bit of a messy situation.  The lower walls are coming up 

the same height as they were, they haven't been modified, but they are overlapping that slab.  So what 

I'm going to do is select all four of them, and I can do this numerically or I can just go to the top of one of 

them and - if I do this correctly here - press down and use the pet palette to change the height.  

[0:03:22] 

And then when I change the height I can snap to the bottom of the slab.  So now you can see that they 

are stacked, however we are seeing a contrast in color.  If I take this slab and select it, and go to its 

materials and say that I'd like the outside edge material to be the same as the walls, then you're going to 

see it disappear.  It's still there of course, but because it shares the same material as the walls above and 

below and it's in the same plane, ArchiCAD removes the line.  [0:03:01] 
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So this is another way that you can create your buildings. You can literally stack the wall slab and next 

wall up and get a reasonable result.  Let's go to the floor plan and actually draw a section and see the 

difference in what we see at this point.  When I open that section, we will see that in the first case we've 

got the slab in between the walls.  And the second case we have the slab extending out to the edge. 

[0:04:39]   

Now in the real world obviously this slab is actually going to go into the wall and sit on top of the 

framing, at least that would be the common way that it's constructed for residential buildings in the U.S.  

So I'm going to show you how you might accomplish that.  And as we start to do that, we might want to 

think about creating these walls with more detail, actually having them with composites as well.  

[0:05:06] 

Let me go here on the floor plan and we'll start on the lower story.  And I will go ahead and select these 

four walls here and choose, in this case instead of just a simple fill, I will choose something that has 

more detail.  So you can see how I've added a lot more information by just selecting a particular type.  

Now I'll use the eyedropper to pick this up so that when I go up a story I can go up and inject it. I can use 

the Syringe command option or Ctrl+Alt to inject it into those walls.  [0:05:52] 

Now I will go to the interior ones and we'll do a different composite here that might be appropriate for 

an interior wall type.  So at this point we've got now some wall assemblies chosen and if I go into the 

section, we will see a different appearance.  We're starting to actually have something that's almost 

suggestive of what it should be where the slab is sticking into the wall.  It has to go a little further and 

we don't want to see the line of the wall through it, we want it to be clean.  [0:06:27] 

So the way that we can get it to be clean is I can go select the slab. Actually we'll go and use the Design 

menu, Solid Element Operations palette.  If you are in ArchiCAD 15 it became temporarily under the sub 

menu under Connect, it was here, but in other versions of ArchiCAD, it's directly under the Design menu.  

Now having done that, I'm going to select the slab and make it the operator.  It's going to control the 

action.  And then I will select the wall here and make it the target so it's going to be affected. [0:06:59]  

Subtraction is what I want, I will tell it to execute.  And you can see how it is then in a split second 

cleaned up that relationship.  So now it didn't do it on the other side because I really also needed to 

select this wall as the target.  And in fact, I need to select all similar walls. So rather than try to do it one 

by one in every section, I can just do this in 3D. Let's go and show everything in 3D and look at how we 

can select all similar elements; all of the walls of this type that need to be subtracted or affected.  

[0:07:36] 

So I will go to the Edit menu, Find and Select.  And when we do find and select, we can choose what the 

criteria is.  And I'll use the eyedropper to pick up this wall, because this is typical of what we want it to 

affect.  Now it says alright, we'll be able to select all walls.  If I hit the plus sign it will select all of them, 
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that's way too general.  But having picked up the information from here, if I click Add, I can then say 

well, you really should be only the ones with a particular fill type, that complex fill that I made for the 

wall. Hit the plus sign. Now it's selecting all the ones in this building, both lower story and upper story. 

[0:08:16]   

Well I really want to be a little bit more specific so I will click on add and choose, for example, elevation. 

And then basically the wall that I had eyedropped was at zero, so when I use the plus sign here, it's 

selecting only similar walls that are at that same elevation, that same fill.  Now this is a good find and 

select that I'm going to use more than once, then I might want to store this criteria by name.  And let's 

just call this "Exterior Walls Ground Floor".  [0:08:49] 

So now this particular criteria can be picked from the menu here at any time to be able to select with 

this little plus sign.  Now having just selected it here, we can go and make them the target and then go 

select the slab like that and make it the operator and do the subtraction and execute.  So now what's 

going to happen is in any view, any section that we do, we're going to have a nice clean result.  So it's 

very easy to essentially draw these things and then have the Solid Element Operation be done for 

everything that's similar and very quickly get the model into shape.  [0:09:36] 

Now this is not going as far as it needs to.  I can easily control that in the floor plan by selecting the slab. 

And you can see how it's very clear; it's just stopping dead in the middle of the wall.  Press down here 

and use the offset. In this case, I'll just offset it directly to the face of the framing here. And now it's 

cleaned up there on the plan.  And if I go to the section, we will see also that it has adjusted nicely into 

position. [0:10:07] 

So let's look at another topic that comes up from time to time, and that is what happens when we want 

to have a slab like this actually have one material in one area and a different material in this room for 

example or multiple different ones in different rooms in the building.  Well, a simple way to handle this 

is to select the slab and remove the area using the pet palette subtraction. Remove the area of this 

room and then I will just eyedrop it.  So I can draw another slab similar, but before I draw it, I will go 

ahead and change the material for the top surface to something else, perhaps a tile.  [0:10:58] 

Then I will go and draw that into place.  Now in 3D, we are going to see that I have now a different color 

for the floor.  Now what if we wanted to make the walls a different color as well?  Well, I can select 

these two interior walls, for example, and go into their settings.  The reference line is the side that faces 

the inside of that room, and I can just go here and select a different material.  Let's just put them into an 

orange color so it's very obvious. And you can see how that has changed there.  [0:11:32] 

Now when I want to do this for the exterior walls, the problem is that this wall spans both this room and 

adjacent areas, so I need to split this into pieces just like I split the slab into multiple pieces.  So I will go 

back to the floor plan and select this wall here, and I could use the split.  In some cases this will work 
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directly.  I will just go to where I have the reference line side and say that I would like to retain after the 

split this lower piece. But I found sometimes it doesn't like it, at least it won't complete the split this 

way.  So I will use the same split command but I will click on this corner and just draw a line in space and 

then it definitely will split it.  I will go ahead and do the same thing with this wall and use the split and go 

from this corner down and retain this piece, and then I can select the two pieces of wall that surround 

this room and go into their settings. [0:12:35] 

In this case it's the non-reference side, because the reference side is the outside. And I will put that into 

that same orange color and say OK.  And now if I go to 3D, you'll see that we've got the room with a 

different color floor and different walls. Now there is a bit of a problem here.  There's a line in space 

here, and if I rotate around it's a little hard to see but there is a line there as well.  If I look at the 

elevation, we are going to see a line showing up because we do have these two separate pieces of wall. 

[0:13:06]  

Now we actually don't need to have that, there is a way to clean this up.  If I hide the story levels and the 

elevation - let's just say we go to the story levels and say hide them, then we will see that there really is 

no line between this lower wall and the upper wall because they have the same material.  And these 

two do have the same material but there's something causing this line.  Let's take a look on the floor 

plan and see what's going on.  [0:13:36] 

This wall here, you can see the little dot that is starting here but somehow it's attempting to clean up on 

an angle to this other wall here.  And even though this one is also connected, it's giving way and we are 

seeing the line in space.  The reason is, and it took me a little while to figure this out, is that this wall 

here has the same priority as the other walls.  See the wall priority is number 8.  If I move this down to 

anything lower than that, you will see this slightly shaded area recede back from the face.  So now it has 

less priority than the exterior ones, but it still giving a nice clean result.  [0:14:20] 

When I go to 3D we are going to see that line goes away. And when I go to the south elevation the same 

thing happens.  So I just need to repeat that same little adjustment that I did here with this other piece 

of wall. I'll just change its priority to be lower so it gives way and doesn't extend out to the edge in terms 

of the 3D clean up; and that will make all that we need.  [0:14:52] 

So let's look at how we can take this structure and go even further.  We're going to make a fourth copy 

using a different approach.  Instead of using Solid Element Operations, we're going to use Complex 

Profiles.  So if I open up this section I want to point out that while this is clean, if I were to take this and 

actually make it instead of a simple fill, if I were to put it into a structural floor and a finished floor, we 

have a little bit of a mess.  [0:15:35] 

We can see the finished floor on top, and here is the structural floor, and we're not seeing a line.  So 

let's just take a look at how we can control that.  Under the Options menu, Element Attributes, 
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Composites, we can take a look at this particular one and see that the main fill here is 2x wood frame, 

which is the same as we have in the wall.  This is causing a problem in this case, so what I'm going to do 

is just select a different one.  Instead of the 2x wood frame, I will pick air space.  It looks the same, but it 

has a different name and therefore ArchiCAD will actually just draw a line and say, "Well these are two 

different fills, so they should have the separator line."  So that cleans things up a little bit.  [0:16:23] 

And you notice that this wall gave way, because the solid element operation - basically when the slab 

got thicker, the wall just gave way.  However, the finished floor here in many cases should only go to the 

face of the wall or to just inside the sheathing where the drywall may be coming on top of it.  And the 

framing actually drops down to sit on top of the structural floor.  So how can we achieve that?  One way 

we can do this is to actually break this up into two pieces.  Instead of having a structural floor and the 

finished floor as one element, we could break them up.  [0:17:01] 

This also allows us to have different rooms with different materials.  So let me go to the Options, 

Element Attributes, Composites and we will create a duplicate of this.  In this case, I'm going to make 

just the structural part of it.  Now I could do what I'm about to do without doing it as a composite, but 

I'd like to show you in case maybe there were two or three other skins, we could just take off one skin, 

the top skin.  So I will go and take the top skin and clear it, and now you can see it's got the name and 

just the lower part.  And when I say OK it's defined a new composite.  [0:17:39] 

This particular slab didn't change because it still has the old setting, and I'm going to change it now to be 

the new one, the structural one.  And you can see how it simplified and it's gotten a little tiny bit thinner 

because it removed that structural component.  Now it kept the top surface and I actually wanted it to 

keep the bottom to allow space for the finished floor.  So I'm just going to drag it here using 

Command+D or Ctrl+ D about 3/4 inch, that's about 2 cm down. And you can see how it's changed the 

top height as appropriate.  So it now is in the right place.  [0:18:16] 

This upper wall here, you can see it sitting on top of the story level, and this lower wall actually is 

wrapping around here.  Let's go now to the floor plan and we'll go to the Slab tool. In this case I'm going 

to change it so that instead of it being a composite, I will make just something simple. Perhaps 75% 

poché to make it really visible.  And having made it just a single type of fill, I can then say that I'd like this 

to be only 3/4 inch thick.  [0:18:53] 

And having done that, we can go in here and perhaps draw this only inside the room there.  And now if I 

go back to the section, we will see here is that finished floor only going as far as it should.  Now this line 

of the drywall or sheathing is coming down I'm going to make the finished floor be the operator and 

take this wall and make it the target and subtract it out. And now we will get - if we take this one -

actually I'm sorry, it's this wall here that has to be the target because it's actually below the story line.  

[0:19:52] 
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And this is the operator and subtract.  And now we get the clean result that I was looking for.  So we 

need to repeat that in other places.  And this brings up the idea of is the best way to do this?  We can do 

this with a finished floor, we can add a finished floor in all the other spaces and it will come underneath 

here, but we are going to have - if we were to look closely in the interior - we're going to have the fact 

that the interior walls are sitting at the zero level and are not actually resting on the structural floor.  

[0:20:29] 

So if this is something that when you zoom if you did a detail, that you want to have perfect, let's look at 

how we can actually achieve that.  So at this point we have something that would look good on plan.  I 

have a finished floor that I can make the top surface the tile easily. Here is the structural floor and I 

could have a different finished floor in each room or a number of rooms at a time. But in terms of the 

section, I'd like to make this is even more detailed, even more correct.  So how can I go even further 

than what I have done with the Solid Element Operations? [0:02:15]  

Let's take a look at how you can work with Complex Profiles to do this.  So if I go back to this section 

here, and I'm going to simply create three wall types, complex profiles that will do this very quickly.  I 

will select this one, this wall, and I will capture the profile.  With that means is it will open up the profile 

manager with a copy of what I was looking at.  It happens to be reversed left to right because of the way 

that it orients things.  But here's the framing line here, you can see it's sort of mirror image from that. 

[0:21:55]   

What I want to do is actually bring this fill that represents the framing area down using the pet palette, 

just the standard controls, a certain amount. And then I'm going to go do the same thing with this one, 

this fill, and snap it into position here.  So now this wall is actually notched for where the slab would fit 

in.  I will store this as "Wall Type 1".  Now I'm going to go back and do a similar thing.  I will select this 

wall and capture it. And here I simply want to go into the framing area and pull it down by the thickness 

of the finished floor.  And store this as "Wall Type 2".  [0:22:57] 

And then we will go the interior wall as a typical wall and capture this for use. We'll make the center 

area here go down the thickness of the finished floor and store this as "Wall Type 3".  Now having done 

that quick little work, I can go create a detailed structural model of this building in a jiffy.  So let's go 

down to the lower story, go to the Wall tool, make sure that the wall is set to start at zero here and that 

we're choosing a composite, wall type 1.  And I'll draw a box of walls just like I did before and line this 

base up here.  [0:24:15] 

So I'll just do the same size and go up a story and we'll change this to wall type 2.  Draw this and then 

change to wall type 3. And we'll do this with the interior walls and do something roughly the same size 

of room like that.  Now if I look in 3D, we're going to see the new building. No big surprise there, but 

let's take a look at the section.  And you'll see the new walls actually are notched out.  Here is wall type 
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1, here is wall type 2, you can see how it comes down in there. It's got the space, it's waiting for the slab 

to be put in, and here is the interior walls wall type 3 going down like that.  [0:25:31] 

So these are all nice, clean results here.  Then we just go and put in the slab. So I'll go put in the 

structural slab and eyedrop this one. This will go on this corner of the structural area to that corner. And 

then I'll go and eyedrop the finished floor piece and zoom in on this. We'll put it in here and zoom in on 

the corner. Put it into there, and now let's take a look at that section.  And you can see we've got a 

beautiful, clean result with the structural slab, this finished floor slab here. And even over in the center 

area it's looking just the way it should.  [0:26:37] 

We've managed to get a very clean looking section just simply by drawing with these complex wall 

profiles just as easily as if we had drawn with standard walls.  Now these wall profiles, these complex 

custom profiles, can even go much further.  And I will give you just a little taste in MasterTemplate.  We 

have a huge number of parts that you can eyedrop.  These are setup for quick access of commonly used 

parts. And you can extend this any way you like.  [0:27:16] 

One thing that we will take a look at right now is a set of walls that are really examples of how you can 

do things.  If I use the Marquee tool, and we'll take a look at this, these profile walls - and I will just show 

them here - these profile walls each have a lot of detail.  You can see that when I select it, this wall is 

notched out for a slab and not only that; it actually has waterproofing built in like this.  So it's got a lot of 

information already in the component. So it will show up nicely in a model like this.  [0:27:59] 

You can see even down below the floor line how the sheathing is extending down below where the slab 

would go.  Now beyond just the model, if I go back to the floor plan and I use the Section tool and I say 

draw a little section through here and we take a look at the section just raw, we're going to see that this 

wall not only has that waterproofing detail but it has all this framing.  Now that I've demonstrated the 

other things, you'll be able to understand this very quickly. If I go to this profile, which happens to have a 

name of "wall corrugated panel plus parapet", if I go to that particular profile in profile manager and I 

say edit, it we will see that each of these is a fill just like the ones that we were working with.  [0:29:07] 

The waterproofing detail here is also a fill.  You can see just with a different setting.  And these elements 

here which give us the framing, they are not lines, they are fills.  So here is a fill, here's another fill.  Now 

ArchiCAD is remembering to put lines in here because this fill is "Empty 2", this fill is "Air Space"; this fill 

is "Empty Fill".  Each one of these has a different name.  So with three or four of those with different 

names but basically with no line work there, they show up exactly like you would hope with these lines.  

So every one of these is a separate fill but it looks like we have two x's indicating the framing.  [0:29:58] 

So this allows us to have in that section the actual framing information as well as the water proofing and 

all of the other interesting details down here.  So I hope this has opened your eyes to some possibilities 

for going from very simple modeling to more complex modeling here. And yet all of it, once you 
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understand it can be done very quickly.  You saw how I was able to draw this building with the complex 

profiles just as quickly as I had drawn the earlier buildings, but the section, when I open that section up 

is just way more clean and correct. All of that information is already in there.  And if I were to do these 

walls with the framing like I showed you in the other file, then we would have a section that basically 

was ready to go, all you might have to do is annotate it. [0:30:59] 

So this has been Eric Bobrow. I look forward to getting your comments and questions, please post them 

on the page down below. Thanks for watching. 

[END OF AUDIO 0:31:11] 


